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Martin Lynch and Sons of London supplies all radios used by 
HB9DRV and GD4ELI. 

Special thanks are due to Chris Taylor for his friendly and efficient 
service.  

 

 

 

 

If you are looking for a new radio to use with digital mode software 
I recommend Kenwood’s TS-480SAT. It offers excellent value for 
money, is very easy to use and has the best computer support 
available today.
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Introduction 

Digital Master (DM780) is a new program supporting the most 
commonly used digital modes, a replacement for PSK31 Deluxe. 
DM780 is closely integrated with Ham Radio Deluxe. 

Too see what is new look at the Change Log (page 65). 

Supported Modes 
The first release supports PSK/QPSK 31/63/125 using the PSK 
engine developed by Moe Wheatley AE4JY and modified by myself. 
The source for the DLL is available, if you can’t find it on the Ham 
Radio Deluxe website just ask and I’ll make sure it’s available. 

In DM780 you find all the features you expect of a modern program 
such as an integrated logbook, world map and web browsers. The 
DM780 philosophy is to get the UI working properly before more 
modes are added. 

The development target is to support the commonly used digital 
modes by the end of 2007, these modes being: 

• CW  

• DominoEX 4, DominoEX 5, DominoEX 8, DominoEX 11, 
DominoEX 16, DominoEX 22 

• Feld-Hell, FSK-Hell, FSK-Hell 105 

• MFSK-8, MFSK-16, MFSK-16 pix  

• OLIVIA various tones and bandwidth  

• RTTY various Baud Rates, Shifts, Number of data bits, etc.  

• Throb-1 Throb-2 Throb-4 ThrobX-1 ThrobX-2 ThrobX-4 

The above list is taken from Fldigi, a fine digital mode program for 
Linux. For more information: http://www.w1hkj.com/Fldigi.html . 
The author of Fldigi, W1HKJ has kindly allowed me to use his code 
for these modes. 

Once this is work is finished WSJT will very probably be added. 

Operating System Support 
DM780 is designed for Windows 2000, XP and VISTA. Older 
versions of Windows such as Windows 98 are not supported. 

There are no plans for Linux or Mac OS versions. The UI code 
cannot be made available; also it is not possible to port it to a 
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UNIX-based operating system. If you want a UNIX / Linux solution 
look at Fldigi (see above).  

VISTA 
Although the first release works with VISTA, the soundcard names 
and input sources will not be displayed with the same titles seen 
when using VISTA’s soundcard programs. To add correct support 
for VISTA more code must be written on a VISTA development 
machine, this will be part of the second release of DM780. 

Hardware Requirement 
Although one member of the test team has satisfactory results 
using a 500 MHz CPU and Windows XP a realistic minimum system 
would be a 1 GHz Intel CPU and 512 MB of RAM. 

A high-end soundcard such as the M-Audio Delta 44 is not essential 
but recommended. 

If you are using a laptop be aware that the internal soundcard may 
be very poor indeed, consider the SignaLink USB from Tigertronics 
http://www.tigertronics.com/ . 

Meet The Users 
The HRD and DM780 support forums are found at 
http://forums.ham-radio.ch/ . 

You do not need to register to view the forums!  
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Getting Started 

 
Follow these steps to configure DM780 and enjoy your first digital 
mode QSO. 

Audio Interfacing 
You need an audio interface to connect your rig's audio in/out to 
the computer's soundcard. This eliminates troublesome ground 
loops and prevents hum and noise from degrading the signals. 

Audio interfacing can be done in so many ways that it would take 
days to plough through all the available information. It is possible 
to connect your radio directly to your soundcard without any form 
of isolating interface but this is not recommended. 

Commercial Solutions 
From England there are the ZLP Electronics DigiMaster interfaces, 
inexpensive, very well made and used with my TS-480SAT. 

 

From Oregon USA, Tigertronics manufactures the SignaLink 
interfaces, used with my IC-703 and FT-817. 

  

From Connecticut USA, West Mountain Radio provide the 
RIGBlaster solutions. 
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DIY 
Here is a circuit recommended by Peter PH1PH (SK), this text was 
written by Peter in 2004. 

"Here is a circuit that has proved its worth many times. It will work 
with any ICOM or Yaesu rig that has a 6-pin mini-DIN connector for 
external audio. It will of course work on just about any other rig 
that exists, but you will have to make changes to the connections 
to your radio. Please check the actual connections to the mini-DIN - 
I can accept no responsibility for damage to your rig should things 
go wrong. I have to say that the one that I built to this circuit 
worked perfectly well on my FT-817 and IC-703 without changes..." 

"You should always use the rig's high-impedance audio output if 
there is one available: this supplies a constant signal level to the 
soundcard. Most rigs also have a TX audio connector independent 
to the microphone input: you are advised to use this input. Some 
commercial interfaces don't allow this: my recommendation is to 
avoid any interface requiring use of the microphone connector and 
speaker output unless there is no other option for getting signals in 
and out of the radio." 
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Tags 
Enter values in the Tags window; these values are used in macros 
(shortcuts which save you entering the same text every time you 
have a QSO). The values are saved automatically. 

 

 

Soundcard 
Select your soundcard as follows: 

Either: 

• From the View menu select Soundcard, 

• In the Soundcard pane press the Options button. 

Or: 

• Press F8 to display the Program Options (or select Program 
Options from the Tools menu), 

• Select the Soundcard page. 

 

 

A good soundcard is recommended; some PC's come with very poor 
solutions built onto the mothercard (this is especially true for 
laptops). You can use the PC's default soundcard to get going, but 
the difference between a poor soundcard and a card such as the M-
Audio Delta 44 or a Creative Audigy is like night and day. You will 
be able to decode signals much better with a good soundcard. 
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SignaLink USB 
Tigertronics make a great external soundcard that you connect to a 
USB port on your computer; this is the SignaLink USB, which also 
provides an audio interface between the radio and PC to isolate 
your computer from your radio. 

Available direct from Tigertronics and Martin Lynch & Sons (UK). 

 

An advantage of a second soundcard is you can use the internal 
card for normal Windows sounds and the DM780 alarms. 

Radio Control 
DM780 uses Ham Radio Deluxe (HRD) for radio control. To set up a 
connection between DM780 and HRD: 

• In DM780 open the Radio display (select Radio from the 
View menu), 

• Press  Configure (the right-most button on the toolbar), 

• Read the help text, this contains everything you need to 
know! 
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To configure the radio interface: 

• Make sure Ham Radio Deluxe (HRD) is started and 
connected to a radio, you must use build 1317 or later. 

• In HRD select IP Server from the Tools menu, make sure the 
IP Server is started and is configured to start when HRD 
starts. 
 

 

• In DM780 select Radio from the View menu, in the Radio 
pane press the Configure button. 

 

In the Configure Radio Pane window: 

• HRD address - the address or name of the computer where 
HRD is running, localhost (or 127.0.0.1) if the local 
computer. 

• HRD port - the default port is 7809. 

• Press Connect to HRD. 

 

If a connection can be established: 

• All buttons are enabled, 

• The Dropdown buttons are automatically loaded with the 
dropdown buttons shown the HRD's display, 

• The TX push button is automatically loaded (if available for 
your radio). 

• TS-480SAT - the TX Alt button is used for PTT via the rear 
connector. 

 

To change a selection click on a button, then select an entry from 
the popup window. To clear the current selection, select the first 
entry '- - -'. 

When you have finished defining your layout press Save. The 
definitions are saved in your local storage folder (from the Tools 
menu select Program Options, then select the Storage pane). For 
example, the IC-703 definitions are stored in DMRadioLayout_IC-
703.xml . 

In the Radio pane press the Connect button  to connect to HRD. 
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PTT 
Normally you use HRD for PTT control, PTT is configured on the PTT 
pane of the Program Options (page 61). 

 

 

COM Port 
To use a COM port for PTT: 

• Select [X] Enable PTT... 

• Select the COM port; this must not be in use by another 
program, 

• Select DTR, RTS or DTR and RTS. 

When you switch to TX DTR and/or RTS are set (raised), when you 
return to RX they are cleared. 

Ham Radio Deluxe 
To use HRD the radio pane must be connected to HRD: 

• In the View menu select Radio 

• In the Radio pane press Configure and read the instructions!
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Your First QSO 

If a QSO window is not displayed just press the QSO button. A 
typical QSO window layout is shown below. 

 

 
 

QSO Window 
The major components of the QSO window are: 
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• Logbook (Add Log Entry) add an entry to DM780’s logbook. 
Click on the tabs to select the pages. 

 

• Macros, Tags, Modes: 

o Macros – pre-defined text that you use when 
composing the text you want to send. 

o Tags – information about yourself and your station, 
which is organized into fields, which in turn are used 
by macro definitions. 

o Modes – add modes currently supported by DM780. 

• Receive window – decoded text is displayed here. 

 

• Transmit window – the text you send is composed here. 

 

• Waterfall - at the bottom you see the Waterfall, the red 
stripes are PSK31 signals. To select a signal, just click on 
the stripe. 

More Detail 
If the Waterfall is not displaying signals, check: 

• Your radio is switched on, 

• The correct soundcard is selected, 

• The correct input source is selected and enabled, 

• The cables are correctly connected to your radio and 
soundcard interface. 

Mode 
Select the correct mode. The default is PSK31, used in 95% or 
more PSK QSO’s. Select the mode with either: 

• The dropdown option in the receive window, or 
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• The Modes pane. 

Transmitting 
Before you make your first test transmission you must decide how 
you will switch your radio between transmit and receive. 

The options are: 

• PTT using a serial (COM) port, 

• PTT via Ham Radio Deluxe, 

• VOX (depends on your radio and soundcard interface). 

To select PTT open the PTT page of the Program Options (selected 
from the Tools menu). 

Test Transmission 

It is very important that you transmit a clean, linear signal. 
Never, ever use any compression or ALC. 

To transmit just press either: 

• Send (F1) – starts sending, when all text has been sent 
press Stop (F4). 

• Auto (F2) – starts sending, stops when all text has been 
sent. 

 

When you start sending you will see the classic PSK ‘tramlines’ in 
the waterfall window: 

 

When text is being sent the signal looks like this: 

 

If you have configured your radio interface correctly your radio will 
switch to transmit mode when you start sending. 

Using Macros 
To select a macro either: 

• Select an entry from the Macros pane, or 

• Click an entry in the Macros bar. 
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The macros bar is usually the most convenient option. In the 
picture below the macros bar is the second strip of buttons. 

 

In this example the text that has been sent is displayed with a 
blue strikethrough font. 

To directly edit a macro right-click on the button in the macros 
bar. 

Add Log Entry 
Although you can type values into the fields in the Add Log Entry 
window, a faster option is to double-click on text in the receive 
window and select options from the popup menu. 

 

 In this example the text UR4UP has 
been selected. 

(Because UR4UP is an alphanumeric 
string and possibly a valid callsign, the 
entries in the popup window include the 
callsign lookup / QRZ options.) 

To copy UR4UP into the Callsign field in 
the Add Log Entry window just select 
Callsign from the popup menu. 

Hint: if you press Shift while double-
clicking the selected text is copied 
into the Callsign field without 
displaying the popup menu. 

 

 

The entries in the menu are: 

• Worked status, 

• Lookup using QRZ.com or DM780’s Callsign Lookup window, 

• The Add Log Entry fields – the main fields are supported, 

• Copy to clipboard, 

• Add Alarm – create an alarm from the callsign, 

• Google for the callsign. 
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Add 
This page contains the most commonly 
used fields. 

Start and End Times 
The times are usually shown using UTC, 
use the Program Options / Logbook 
pane to select either UTC or Local time. 
The time is always stored in the logbook 
using UTC. 

Start 
The start time for the QSO. If you check 
[_] Now the start time is updated with 
the current time. 

In the Program Options / Logbook pane 
optionally select: 

Update when adding callsign - the time 
is updated when you add a new value in 
the Callsign field if previously empty, 

Update when adding logbook entry. 

End 
The end time of the QSO. If you check 
[_] Now the end time is updated with 
the current time. In the Program 
Options / Logbook pane optionally 
select: 

Update when adding logbook entry. 

Callsign 
The station contacted. When you enter the callsign the Country is 
updated automatically. This field is mandatory. 

Name 
The operator's name, free-format text. 

QTH 
The operator's location, free-format text. 

Locator 
The Maidenhead locator, usually 6 characters, for example JN46pt. 

Country 
Updated automatically when you enter a callsign, the list shown 
corresponds to the latest DXCC list of countries. 

Frequency 
The current frequency, updated automatically from the Radio pane. 

Band 
The current band, determined from the frequency. 

Mode 
The current mode - the list contains the ADIF modes that are used 
for logbook import / export, awards, etc. 

Sent 
Sent has two fields: Report (example - 599) and Exchange (for 
contests). 
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Report 
The standard, select from the dropdown or entered via the 
keyboard. 

Exchange 
To enable auto-incremented values in the Exchange field enclose 
the numeric value to be incremented inside square brackets. For 
example, if you enter [001] then the value added to the logbook 
and inserted in macros is 001 and this value is incremented to 002 
when you press Add. The square brackets are ignored. 

Remark 
A free-format text field. 

More 
This page contains less frequently used 
fields. 

Continent 
Select from the dropdown list. 

IOTA 
Islands On The Air reference – the IOTA 
hompage is: http://www.rsgbiota.org/ . 

Age  
The other station’s age. 

URL 
The other station’s homepage. 

Contest 
If the contact is made during a contest, 
enter the name of the contest here. 

A index, K index, Solar flux 
The current space weather information 
available from NOAA via WWV.  
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My Station 
This page contains information about your station. As you may 
have many configurations up to ten different station profiles are 
supported. 

After you have entered values press Save. 

Use the Copy To option to save the current values to a different 
profile. 
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Advanced QSO Options 

Squelch 
The Squelch control operates in a similar way to the squelch on 
your FM receiver; the signal is only decoded when the strength is 
equal to or greater than the squelch setting. 

 

 

In the above example the squelch threshold is set to 25 (the 
available range is 0 to 100), the actual signal level is significantly 
higher. 

AFC 
Automatic Frequency Control ensures that you track a signal which 
may be drifting, also that your receive frequency is in the center of 
the signal. 

The normal value is +/- 50 Hz, this tracks within 50 Hz 
of the signal. 

If the value is set too high there is the risk of being 
moved from a weak signal to a stronger near-by 
signal. 

Signal Quality 
The quality of the received signal is shown in the vector data 
display. 

 Vertical lines like this indicate a good PSK signal. 

 Random lines like this indicate a bad PSK signal. 

Multi-Channel Support 
The standard QSO window supports 1, 2 or 3 receive channels. 



 

 
22

 One channel (Main). 

 Two channels, Main and Sub-A. 

 Three channels, Main, Sub-A and Sub-B. 

 

You can only transmit using the Main channel, Sub-A and Sub-B are 
receive only. 

Use the  button to swap the contents of Sub-A or Sub-B with the 
Main channel. 

An alternative to multi-channels is the SuperBrowser. 

Split Mode 
To enable split mode operation just press the split mode button . 
Instead the main channel marker  is replaced with a transmit  
and receive  marker. 

To change either frequency click on the marker, then drag over a 
signal trace. 

Repeats 
To send text at a regular interval use the repeat option. Typically 
you use this option to send a CQ text on a normally quiet band 
such as 50 MHz. 

There are two buttons associated with repeats: 

 Select the repeat interval. 

 Enable repeats. 

 

When a repeat interval is selected a progress bar is displayed at the 
bottom of the transmit window (on the window’s status bar). 

For example, with an 8 second interval:  

Waterfall 
The waterfall is your tuning dial; you select the signal to decode 
and if in split mode your transmit frequency. 
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The waterfall display consists of: 

• Main toolbar, 

 

• Favourites toolbar, 

 

• Modes toolbar, 

 

• Markers, 
 

• Frequency, 

 

• Signal traces. 

 

Main Toolbar 
The main toolbar options are: 
 

 Show frequency spectrum 

 Display mode – various algorithms to pull the signal 
trace out of the background noise. This does not 
affect the signal decoding. 

 Show radio frequency (frequency of radio + audio 
offset). 

 Rewind the display – replays the stored audio. 

 Maximise the contrast (this does not affect the 
signal decoding). 

 Enable info popups – the trace under the cursor is 
decoded, the result displayed in a small popup 
window.  
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 Waterfall options. 

Favourites Toolbar 
The favourites toolbar contains the frequencies you commonly use, 
it is provided to make switching between these frequencies as 
painless as possible. 
 

 A favourite frequency (not selected). 

 The currently selected favourite frequency. 

 Adjust frequency by +/- 500Hz. 

 Start the favourites manager. 

 

Modes Toolbar 
The modes toolbar contains the modes you commonly use. 
 

 
A favourite mode (not selected). 

 
The currently selected mode. 

 
Start the modes manager. 

 

Markers 
The various markers you will see in the waterfall are shown below. 
To change a frequency click on, then drag the marker over a signal. 
The cursor indicates the marker you are dragging. 

To change the main channel frequency just click in the waterfall. 

 

 A current Main channel frequency. Split mode  must be off. 

 The current channel Sub-A (VFO-A) frequency. 

 The current channel Sub-B (VFO-B) frequency. 

 If split mode is enabled this is the receive (RX) frequency. 

 If split mode is enabled this is the transmit (TX) frequency. 

 Center frequency – see Center Frequency on page 64.  
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Appearance 
The waterfall appearance is configured with the Waterfall page of 
the Program Options (selected from the Tools menu). 

 

The most commonly used options are Colour File and the Display 
Mode settings. 

Select the colour file that is best for you, (I prefer Scope 1). 

The display mode settings adjust the data to make the signal traces 
more prominent; this has no effect on the decoding. The default 
setting is shown in the above screenshot. 

Options 
There are three panes in the Program Options (page 61) used by 
the QSO window: 

• QSO:General, 

• QSO:Receive and 

• QSO:Transmit. 

Familiarise yourself with the options on these panes.





 

 

U s e r  G u i d e

27

Logbook 

Every modern program has a built-in logbook; DM780 is no 
exception. The database engine is taken from Ham Radio Deluxe; 
the operation will be familiar to anyone who has used Ham Radio 
Deluxe. 

There are two logbook windows: 

• Quick log - a docking pane that shows the most recent 
entries, designed as a quick reference window. 

• Main logbook - this is the option you select for general 
logbook maintenance. 

 

 Whichever window you use – TAKE REGULAR BACKUPS! 

Quick Log 
Select Display Quick Log from the Logbook menu or Quick Log from 
the View menu to display this window. 

Much simpler than the main logbook window, this is a docking pane 
with only the most basic options available, selected from the 
toolbar.  

 

 

 Fit to Text 

 Refresh 

 Modify 

 Delete 

 Max Entries 
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 Plot 

 Backup 

 Enable Filter (find by callsign) 

 Apply Filter 

 Options 

 

If the  Find option is enabled then any callsign entered in the Add 
Log Entry window is automatically applied here. 

To try this: 

1. Make sure the Quick Log window is displayed. 

2.  Find must be selected. 

3. In the Add Log Entry window enter a callsign in the Callsign 
field. 

All previous QSO’s with this station are now shown. 

Main Logbook 
Select Display Main Logbook from the Logbook menu or press the 
Logbook button on the main toolbar. 

 

Note: The selection fields at the top of the window are enabled 
when the Advanced button is pressed. 

All options are selected from either the Logbook menu, the context 
(right-click) menu or the toolbar. 

Layout 
The column layout is user-definable. Select the columns and the 
order in which they are displayed. 
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Save up to four custom layouts. 

 

ADIF 
Amateur Data Interchange Format (ADIF) files are used to 
exchange QSO information between logging programs. In DM780 
you can save (export) the logbook to an ADIF file and load (import) 
an ADIF file into the logbook. 

Export 
Create and ADIF file to send your records to another logging 
program, Logbook of The World (LoTW) or eQSL.cc. 
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After selecting the output file you select the fields to be included in 
the file. 

• ADIF / LoTW: the fields supported by ADIF 2.0 (also 
required by LoTW). 

• ADIF + Ham Radio Deluxe: all fields. 

• EQSL: only the fields required by eQSL – this makes the 
ADIF file smaller and the eQSL upload faster. 

An example of an ADIF file containing a single record is shown 
below: 

 
#++ 
# 
#   Digital Master 780 version 1.0 build 1431 
#   http://www.hb9drv.ch 
# 
#   Free software for ever! 
# 
#   Created:  28-Mar-2007 20:54:55 
#   Database: C:\Documents and Settings\…\HRD Logbook 19-
Mar-2007 230254.mdb 
#   Exported: 1 record 
# 
#-- 
 
<ADIF_VERS:3>2.0 
<PROGRAMID:14>HamRadioDeluxe 
<PROGRAMVERSION:22>Version 1.0 build 1431 
<EOH> 
 
<call:5>NP2KW <qso_date:8:d>20070201 <time_on:6>091822 
<band:3>40m <mode:5>PSK31 <rst_sent:4>599  <a_index:2>18 
<cont:2>NA <dxcc:3>285 <freq:8>7.034500 
<gridsquare:6>FK77np <iota:6>NA-106 <k_index:1>4 
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<my_city:8>Wickford <my_cnty:5>Essex 
<my_country:7>England <my_cq_zone:2>14 
<my_gridsquare:6>JO01go <my_iota:6>EU-005 
<my_itu_zone:2>27 <my_lat:8>51.60545 <my_lon:7>0.54845 
<my_name:5>Terry <my_postal_code:8>SS11 8XN 
<my_rig:33>Yaesu FT1000 MkV + Balanced tuner 
<my_street:18>2 Coltishall Close <name:5>Manny 
<operator:5>G6CNQ <owner_callsign:5>G6CNQ <qth:18>St 
Croix, Vi 00821 <rst_rcvd:4>599  <sfi:2>89 
<station_callsign:5>G6CNQ <time_off:6>092252 <tx_pwr:8>40 
watts <EOR> 

Import 
Use this option to load and ADIF file into your logbook database. 

 

When importing an ADIF file the band information may be missing, 
if you check the option: 

 

the band is recomputed. 

If the DXCC information is missing you can generate this by 
checking: 

. 

 

The first step is to load the file; the records are shown in the 
bottom half of the window. If you are satisfied that the information 
shown is correct you save this information to your database. 
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Cabrillo 
Many contests require the log in Cabrillo format (why they can’t 
just load an ADIF file is a mystery). 

 

Not all Cabrillo templates are supported - these are added as 
required. 

Merge HRD 
You can load (import) records from another logbook providing it is 
already in the HRD format. 

Typical use would be to import a database created during a contest 
of an expedition to an exotic location or while using your laptop 
from a portable site.  

 

Duplicate QSO’s are ignored when you press Load. 
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Google Earth 
Selected entries can be sent to Google Earth, a fantastic program 
available for free download. 

 

 

The interface to Google Earth is a Keyhole Markup Language (kml) 
file. 

Note: Home information is taken from the Tags window shown 
in the QSO Windows. 

 

Analysis 
The current analysis shows DXCC, IOTA, QSO and Grid squares by 
band and mode. 

Printing is supported! 
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SuperBrowser 

The aim of the SuperBrowser is to display as many PSK QSO’s as 
possible. 

Not only display – you can have a QSO using the SuperBrowser! 

A standard display is shown below. From left to right: 

• Frequency, 

• Waterfall, 

• Active channels. 

At the bottom you see the status bar, containing: 

• Current soundcard selection, 

• Active channel count / total channels, 

• Hold time before a channel is no longer shown, 

• Audio rewind when a new signal is detected, 

• CPU used by the background SuperBrowser processing, 

• Overload status (incoming signal level is too high), 

• Current AFC setting. 
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In this example the callsign RU6DZ has been reliably identified, so 
is shown at the beginning of the channel. 

The  icon indicates that you have not worked RU6DZ on this 
band. If you have worked RU6DZ the  icon is displayed. 

Options 

Main Toolbar 
The main toolbar options are: 

 
Mode selection 

 
Squelch level 

 

 
Squelch value 

 
AFC 

 
Max Entries 

 Plot 

 Backup 

 Enable Filter (find by callsign) 

 Apply Filter 
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 Options 

 Waterfall display mode 

 Number of channels 

 Options 

 

Favourites Toolbar 
The favourites toolbar contains the frequencies you commonly use, 
it is provided to make switching between these frequencies as 
painless as possible. 
 

 A favourite frequency, not selected. 

 The currently selected favourite frequency. 

 Adjust frequency by +/- 500Hz. 

 Start the favourites manager. 

 

Transfer To QSO Windows 
Double-click on a channel to transfer the settings and data to a 
main QSO window (not the built-in QSO window). 

Press shift and click on a channel to open the SuperBrowser QSO 
window (if not already open) and select the channel. 

QSO Window 
Press the button to display the SuperBrowser QSO windows: 

• Add Log Entry, 

• QSO: RX, 

• QSO: TX. 

These windows are the same as those in the main QSO window 
(page 13). 

Click anywhere in the channel text (not the callsign or icons) to 
select a different channel. 

Click anywhere in the waterfall to change the frequency of the 
current channel. 
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Options 
Press F8 to display the Program Options (or select Program Options 
from the Tools menu), then select the SuperBrowser:1 or 
SuperBrowser:2 page to view the available options. 

Visual 
The SuperBrowser:1 page concentrates on the appearance of the 
SuperBrowser. 

 

Operation 
The SuperBrowser:2 page concentrates on the way the 
SuperBrowser operates. 
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Web Browsers 

DM780 offers two styles of web browser: 

• A fully featured full-sized browser, and 

• A small docking mini-browser. 

The options available in the mini-browser are a subset of those 
available in the full-sized browser. 

 

 

 

 

 

Both browsers use on the Internet Explorer engine, any settings 
you make with Internet Explorer are automatically applied here.  

Options are selected from the toolbars and the Browser menu. As 
an experienced Internet user you will already be familiar with the 
operation of a web browser. 

Note: when viewing QRZ.com information an auto-close option 
is enabled as QRZ.com makes very heavy use of flash 
animations, flash chews up CPU!
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World Map 

The world map is used to: 

1. Plot the greyscale line, 

2. Show a locator square overlay, 

3. Plot stations as you work them, 

4. Plot locators as they are detected in the SuperBrowser. 

 

The options are: 

 Print the map 

 Print preview 

 Save to a file 

 Show greyscale 

 Show gridlines 

 Show locator overlay 
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 Select aspect ratio 

 Set text size 

 Zoom In (+) 

 Zoom Out (-) 

 Zoom 100% 

 Select zoom factor 

 Erase plots 

 Show home location (as defined in Tags window) 

 Select time offset, +/- 24 hours 
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Alarms 

In the QSO windows you use alarms to monitor received text for 
special callsigns, locators or any string you want. 

Manager 
To define alarms select Alarms Manager from the Tools menu. 

 

The options are selected from the toolbar. 

 Callsign Create a ‘quick’ alarm definition from a callsign. 

 New Create a new alarm definition. 

 Copy Copy the currently selected definition. 

 Edit Edit the currently selected definition. 

 Delete Delete the currently selected definitions. 

 Up Move the currently selected definition up. 

 Down Move the currently selected definition down. 

 Test Text the enabled definitions. 
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 Import Import from another Alarms set. 

 Load Load from a file. 

 Save Save to a file. 

Editor 
The alarms editor is very simple to use, however you must pay 
attention to the regular expression syntax. 

 

 

Match Text 
The value in the Match field is a regular expression, examples are 
shown below. In the table * represents any character, <spaces> 
matches one or more spaces. 

 

Match Text Description 

HB9DRV *HB9DRV* 

\sGD[0-9][a-z]{2,3}\s Any callsign following a space (\s) starting with 
GD, then a digit (0 to 9), then 2 or 3 letters (a to 
z). 

DM780|Digital Master 780 *DM780* or (|) *Digital Master 780* 

PSK31\s+Deluxe *PSK31<spaces>Deluxe* 

\sCQ\s+CQ\s|\sCQ\s+DE\s <space>CQ<spaces>CQ<space> or 
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<space>CQ<spaces>DE<space> 

\sCQ\s+DX\s <space>CQ<spaces>DX<space> 

VK[0-9][a-z]{2,3}|ZL[0-
9][a-z]{2,3} 

Any VK or ZL callsign 

 

The most commonly used regular expression syntax is: 

Expression Matches 

. Any Character 

[] Character in Range 

[^] Character Not in Range 

^ Not 

| Or 

* 0 or More Matches 

? 0 or 1 Matches 

+ 1 or More Matches 

{2,4} 2 to 4 Matches 

  

Some Examples  

\s Single Space 

\s+ 1 or More Spaces 

[a-z] A to z 

[a-z0-9] A to z or 0 to 9 

[abx] a, b or x 

[0-9] 0 to 9 

[347] 3, 4 or 7 

CQ\s*DX CQ DX 

[gm][a-z]?[0-9][a-z]{2,3} A UK Callsign starting with G or M 

hb9drv HB9DRV 

[a-z]{2}[0-9]{2}[a-z]{2} Locator (e.g. JN46pt) 
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If you use the dropdown 
menu you can build your 
own regular expressions. 

Use the Test option to check 
your definitions. 
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Testing Alarms 
Use the Test option to compare a string with the enabled 
definitions. 

 

 

Enter text in the top window, then press Test. The alarm definitions 
which match are flagged with , those which do not match with . 

Check [_]Include sound effects if you want to hear the alarms. 

Text-To-Speech 
DM780 alarms use Microsoft’s Text-to-Speech solution. This is 
usually installed by default on Windows XP and VISTA systems. 

If you computer doesn’t have Text-to-Speech installed you can 
download it from Microsoft’s website. 
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Identities 

The concept of multiple identities used in DM780 is similar to that 
found in Outlook Express. 

Typical use of multiple identities: 

• At home, 

• Portable, 

• Contest. 

 

All identities share the same 
logbook but are otherwise unique 
(macros, tags, layouts). 

Identity support is selected from the 
File menu. 

 

The Main Identity is used by default. To create / delete an identity 
use the New and Remove options. 

 

To reset an identity (remove all files and clear registry settings) 
press Reset. You cannot reset the Main Identity. 
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Note: The logbook database and registry settings are never 
removed. 

When you press Select DM780 closes and starts using the selected 
identity.
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Logfile 

The logfile window contains diagnostic information used when there 
are problems with DM780. You will not normally display this 
window. 
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Macros 

Macros are used when composing text to be sent during a QSO. 
Using macros avoids repetitive typing. thus ensuring fewer errors. 

Typical uses for macros: 

• Calling CQ, 

• Information about your station, 

• Starting a reply. 

Macros are selected in the QSO windows 
from either the Macros window or the 
Macros toolbar. 

 

 

 

Manager  
To define Macros start the Macros Manager:  

 

• Select Macros Manager from the 
Tools menu, 

• Press Define in the Macros window, 
or 

• Press Define in the toolbar (right-
most button). 

 

 

 



 

 
56

 

Here you define the macros shown in the macros window and the 
macros toolbar. 

The top toolbar contains the Manager options: 

 

• New – create a new macro, 

• Copy – copy the selected macro, 

• Edit – edit the selected macro, 

• Delete – delete the selected macro, 

• Up, down – move the selected macro, 

• Import – load definitions from another macro set, 

• Load – load definitions from a file, 

• Save – save definitions to a file. 

 

The next toolbar shows the enabled definitions as they are shown 
in the QSO windows. 

 

Editor 
The Macro editor window is shown below. 



 

 

U s e r  G u i d e

57

Note: Right-click on an entry in the macros window or macros 
toolbar to launch the editor without starting the Macros 
Manager. 

 

 

 

The components of a macro are: 

Group 
Macros are grouped together in the Macros window (shown in QSO 
windows). 

Title 
As shown in the Macros window. 

Short Title 
As shown in the Macros toolbar. 

[X] Enabled 
Only enabled macros are shown in the Macros window and toolbar. 

Definition 
See below. 

[X] Erase TX window… 
If enabled the contents of the transmit window are erase unless 
either Shift is pressed or you are transmitting. 

[X] Send immediately 
If enabled the macro is sent as soon as it is applied, typically used 
in a CQ macro. 
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[X] Start on new line 
If enabled the macro always starts on a new line when added to the 
transmit window. 

Definition 

 

A macro contains free-format text and optional tags. A tag is an 
item of information, for example his callsign or your output power. 

To insert a tag just double-click on an entry on one of the tag lists. 

The currently supported tags are shown at the bottom of the editor 
window. There are three lists: 

1. Tags (My Info) 
These fields come from the Tags window in the QSO 
windows. 

2. Logbook (His Info) 
These fields come from the Add Log Entry window. 

3. Special 
These are pre-defined. 

A tag is enclosed in <>. The actual substitution is made when the 
macro is selected into the transmit window. 

 

 

Special Tags 
More information about the special tags. 

date Inserts the current date using local time and the user’s 
Windows settings for short dates. 

time Inserts the current time using local time in ISO 8601 format 
(HH:MM:SS). 
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date_utc Inserts the current date using UTC (GMT) time and the user’s 
Windows settings for short dates. 

time_utc Inserts the current time using UTC (GMT) time in ISO 8601 
format (HH:MM:SS). 

add-log The same as pressing the Add button in the Add Log Entry 
window – the QSO is added to the logbook. 

erase Erases the transmit window. 

repeat The same as pressing the Repeat button. 

stop Stops sending. 

 

Preview 
The macro is displayed as it will be sent when the cursor is placed 
over an entry in the macros window or macros toolbar. 

In the example below the cursor is over the Station button. Text 
derived from tags is shown in italics. 
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Program Options 

DM780 is a fully featured program with many displays; as a result 
the level of user customization is very extensive. 

 

You can customize almost every part of 
DM780 by selecting Program Options from 
the Tools menu. 

The Programs Options window is modeless – 
while it is displayed you can still use 
DM780, also any changes you make are 
applied immediately. 

eQSL.cc 
The integrated logbook will automatically upload new contacts to 
eQSL.cc if enabled here. 

 

 

Themes And Skins 
The Theme and Skinning panes define the appearance of DM780. 
Although the defaults should be acceptable there is no harm in 
selecting an appearance you find more appealing. 
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Skins add an extra load on your CPU and graphics card, so if 
you are using an older PC (less than 1 GHz CPU) you may 
consider disabling skins. 

Storage 
This pane provides easy access to the file and registry storage used 
by DM780. The folder names depend on the currently selected 
identity (page 51). 
 

 Don’t mess around with the registry – if you don’t know 
what you are doing leave it alone! 
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Radio Interface 

The radio interface configuration is described in the section Radio 
Control on page 10. 

Favourites 
Use favourite frequencies to switch between commonly used digital 
mode frequencies.  

Manager  
From the toolbar select Manager from the Favourites menu: 

  

 

The favourites manager is a simple list of frequencies that are 
displayed in the dropdown menu and in the favourites toolbar in the 
QSO transmit windows. 
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Options are selected from the toolbar. 

Center Frequency 
If you have a radio with a narrow filter you use this option to 
position the selected signal in the center of your filter. 

In the toolbar there are two buttons associated with this option: 
 

 Enables center frequency operation. 

 Click to apply center frequency. 

 

When enabled, the  marker is displayed in the waterfall. Click and 
drag this to the center of your narrow filter. 

To move the selected signal to the center frequency, click the  
button on the toolbar or double-click the  marker in the waterfall. 
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Change Log 

The change log is selected from the Help menu. It shows my to-do 
notes and current development status. 

I generally record changes and outstanding issues here. 

It is provided for your information, there is no guarantee that 
everything recorded in the change log will be implemented. 
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